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The suggestions included in this checkup are a
compilation of personal cyber security
information from Microsoft, Apple, Google, and
the Department of Homeland Security. By
following these recommendations, you should
have a reasonable expectation of staying safe
while online at your home, however, there is no
absolute guarantee that anything can make you
100% safe from hackers. As new information or
recommendations are released this checkup will
be updated. For any questions please contact us
at mfile@houseoffile.com.

Checkup #1: Your Home WiFi Network

How to Secure Your Home
WiFi Network
With traditional wired networks, it is extremely difficult for someone to steal your
bandwidth but the big problem with wireless signals is that others can access the
Internet using your broadband connection even while they are in a neighboring building
or sitting in a car that’s parked outside your home.
This practice, also known as piggybacking, is bad for three reasons:
•
It will increase your monthly Internet bill especially when you have to pay per
byte of data transfer.
•
It will decrease your Internet access speed since you are now sharing the same
internet connection with other users.
•
It can create a security hazard as others may hack your computers and access
your personal files through your own wireless network.

Where the danger lies - There have been quite a few instances where innocent
Internet users have been arrested for sending hate emails when in reality, their email
accounts were hacked though the unsecured Wi-Fi networks that they had at home.
Wireshark is a free packet sniffing tool for Linux, Mac and Windows that can scan traffic
flowing though a wireless network including cookies, forms and other HTTP requests.
Link to Wireshark software: https://www.wireshark.org
The good news is that it is not very hard to make your wireless network secure, which
will both prevent others from stealing your internet and will also prevent hackers from
taking control of your computers through your own wireless network.
Here are a few simple things that you should to secure your wireless network:

Step 1. Open your router settings page
First, you need to know how to access your wireless router’s settings. Usually you can
do this by typing in “192.168.1.1” into your web browser, and then enter the correct user
name and password for the router. This is different for each router, so first check your
router’s user manual.
You can also use Google to find the manuals for most routers online in case you lost the
printed manual that came with your router purchase. For your reference, here are direct
links to the manufacturer’s site of some popular router brands – Linksys, Cisco,
Netgear, Apple AirPort, SMC, D-Link, Buffalo, TP-LINK, 3Com, Belkin.

Step 2. Create a unique password on your router
Once you have logged into your router, the first thing you should do to secure your
network is to change the default password of the router to something more secure.
This will prevent others from accessing the router and you can easily maintain the
security settings that you want. You can change the password from the Administration
settings on your router’s settings page. The default values are generally admin/
password.

Where the danger lies- There is a public database of default usernames and
passwords of wireless routers, modems, switches and other networking equipment. For
instance, anyone can easily make out from the database that the factory-default settings
for Linksys equipment can be accessed by using admin for both username and
password fields.

Step 3. Change your Network’s SSID
The SSID (or Wireless Network Name) of your Wireless Router is usually pre-defined as
“default” or is set as the brand name of the router (e.g., linksys). Although this will not
make your network inherently more secure, changing the SSID name of your network is
a good idea as it will make it more obvious for others to know which network they are
connecting.
This setting is usually under the basic wireless settings in your router’s settings page.
Once this is set, you will always be sure that you are connecting to the correct Wireless
network even if there are multiple wireless networks in your area. Don’t use your name,
home address or other personal information in the SSID name.

Where the danger lies - Wi-Fi scanning tools like inSSIDer (Windows) and
Kismet (Mac, Linux) are free and they will allow anyone to find all the available Wireless
Networks in an area even if the routers are not broadcasting their SSID name.

Step 4. Enable Network Encryption
In order to prevent other computers in the area from using your internet connection, you
need to encrypt your wireless signals.
There are several encryption methods for wireless settings, including WEP, WPA (WPAPersonal), and WPA2 (Wi-Fi Protected Access version 2). WEP is basic encryption and
therefore least secure (i.e., it can be easily cracked), but is compatible with a wide
range of devices including older hardware, whereas WPA2 is the most secure but is
only compatible with hardware manufactured since 2006.
To enable encryption on your Wireless network, open the wireless security settings on
your router’s configuration page. This will usually let you select which security method
you wish to choose; if you have older devices, choose WEP, otherwise go with WPA2.
Enter a password to access the network; make sure to set this to something that would

be difficult for others to guess, and consider using a combination of letters, numbers,
and special characters in the password.

Where the danger lies - AirCrack and coWPAtty are some free tools that allow
even non-hackers to crack the WEP/WPA (PSK) keys using dictionary or brute force
techniques. A video on YouTube suggests that AirCrack may be easily used to break
WiFi encryption using a jail-broken iPhone or an iPod Touch.

Step 5. Filter MAC addresses
Whether you have a laptop or a Wi-Fi enabled mobile phone, all your wireless devices
have a unique MAC address (this has nothing to do with an Apple Mac) just like every
computer connected to the Internet has a unique IP address. For an added layer of
protection, you can add the MAC addresses of all your devices to your wireless router’s
settings so that only the specified devices can connect to your Wi-Fi network. MAC
addresses are hard-coded into your networking equipment, so one address will only let
that one device on the network. It is, unfortunately, possible to spoof a MAC address,
but an attacker must first know one of the MAC addresses of the computers that are
connected to your Wireless network before he can attempt spoofing.
To enable MAC address filtering, first make a list of all your hardware devices that you
want to connect to your wireless network. Find their MAC addresses, and then add
them to the MAC address filtering in your router’s administrative settings. You can find
the MAC address for your computers by opening Command Prompt and typing in
“ipconfig/all”, which will show your MAC address beside the name “Physical Address”.
You can find the MAC addresses of Wireless mobile phones and other portable devices
under their network settings, though this will vary for each device. (If you ever want to
let a new device connect to your network, you will have to find its MAC address and add
it to your router. If you simply want to let a friend connect to your wireless network one
time, you can remove his MAC address from the router settings when he or she leaves
your place.)

Where the danger lies - Someone can change the MAC address of his or her
own computer and can easily connect to your network since your network allows
connection from devices that have that particular MAC address. Anyone can determine
the MAC address of your device wireless using a sniffing tool like Nmap and he can
then change the MAC address of his own computer using another free tool like MAC
Shift.

Step 6. Reduce the Range of the Wireless Signal
If your wireless router has a high range but you are staying in a small studio apartment,
you can consider decreasing the signal range by either changing the mode of your
router to 802.11g (instead of 802.11n or 802.11b) or use a different wireless channel.
You can also try placing the router under the bed, inside a shoe box or wrap a foil
around the router antennas so that you can somewhat restrict the direction of signals.

Step 7. Upgrade your Router’s firmware
You should check the manufacturer’s site occasionally to make sure that your router is
running the latest firmware. You can find the existing firmware version of your router
using from the router’s dashboard at 192.168.

Connect to your Secure Wireless Network
To conclude, MAC Address filtering with WPA2 (AES) encryption (and a really complex
password) is probably the best way to secure your wireless network. Once you have
enabled the various security settings in your wireless router, you need to add the new
settings to your computers and other wireless devices so that they all can connect to the
Wi-Fi network. You can select to have your computer automatically connect to this
network, so you won’t have to enter the SSID, passphrase and other information every
time you connect to the Internet.
Your wireless network will now be a lot more secure and intruders may have a tough
time intercepting your Wi-Fi signals.

How to Find Out Who is Connected to your
Wireless Network
If you are worried that an outsider may be connecting to the Internet using your
Wireless network, try AirSnare – it is a free utility that will look for unexpected MAC
addresses on your Wireless network as well as to DHCP requests. Another option is to
open your router’s administration page (using the 192.168.* address) and look for the
DHCP Clients Table (it is under Status > Local Network on Linksys routers). Here you
will see a list of all computers and wireless devices that are connected to your home
network.
*It is also a good idea to turn off the router completely when you are not planning to use
the computer for a longer period (like when you go on a vacation). You save on
electricity and the door remains 100% shut for wireless piggybackers.

Checkup #2: Protect Your Home Computers

Antivirus Protection and How to Avoid
Viruses on Windows Computers
Is your computer running more slowly than usual? Does it stop responding, freeze often,
or display other odd behavior? It might have a virus. Fortunately, if you update your
computer regularly and use antivirus software, you can help permanently remove
unwanted software and prevent it from being installed in the first place.
Windows Defender (built in to Windows 8), Microsoft Security Essentials, and other
antivirus software programs download the latest updates over the Internet to fight new
malware. Windows Defender Offline helps protect against advanced malware that can't
always be detected by antivirus software.

How to Remove Viruses
If you can connect to the Internet
Follow the instructions below based on the operating system that your computer is
running. To find out which Windows system your computer is running simply start it up
and as it boots it will show you your system.

Windows 8
If your computer is running Windows 8, you can use the built-in Windows Defender to
help you get rid of a virus or other malware.
Scan your PC with Windows Defender
Here's how:
1
From the Search charm, search for defender, and then open Windows
Defender.
2
On the Home tab, choose a scan option, and then tap or click Scan now.
In addition to the color codes for your PC’s overall security status, Windows Defender
applies an alert level to any suspected malware it detects. You can decide whether to
remove an item entirely, research it further, or let it run because you recognize it.
Review quarantined items
If Windows Defender can’t determine whether a detected item is malware or something
that you intentionally installed, it prevents the software from running but quarantines it
on your PC so that you can decide later.

Windows 7 and Windows Vista
If your computer is running Windows 7 or Windows Vista, do the following:
▪
Run the Microsoft Safety Scanner. The scanner works with the antivirus software
that you already have on your computer, regardless of whether the software is
from Microsoft.
▪
Download Microsoft Security Essentials for free, and then use the software to run
a scan of your computer. For more information, see Help protect your PC with
Microsoft Security Essentials. (Note: Some viruses will prevent you from
downloading Microsoft Security Essentials. If you can’t download the software,
follow the instructions below for using Windows Defender Offline.)
▪
Some malicious software can be difficult to remove. If your antivirus software
detects malware but can’t remove it, follow these steps.

Windows XP
Windows XP does not include virus protection.
Click the security icon on the taskbar, or click Start, select Control Panel, and then
double-click Security Center to find out if you have already installed antivirus protection
from a third party.
Note: On April 8, 2014, Microsoft ended support for Windows XP. This means that there
will be no new security updates available through automatic updating for computers that
are still running Windows XP. Also on this date, Microsoft stopped providing Microsoft
Security Essentials for download on Windows XP. (If you already have Microsoft
Security Essentials installed, you will continue to receive antimalware signature updates
for a limited time, but this does not mean that your PC is secure because Microsoft no
longer provides security updates to help protect it.)

If you can’t connect to the Internet
Windows Defender Offline works with Windows 8, Windows 7, and Windows Vista.
Use another computer to download Windows Defender Offline and create a CD, DVD,
or USB flash drive with the software on it. Then use the media to restart your infected
computer and scan it for unwanted software.

Learn how to avoid viruses
Nothing can guarantee the security of your computer, but there is a lot you can do to
help lower the chances that your computer will become infected.

Use a firewall
Using a firewall is like locking the front door to your house—it helps keep intruders (in
this case, hackers and malicious software) from getting in. Windows Firewall is included
in Windows and is turned on by default.

Update your software
Microsoft releases security updates on the second Tuesday of every month. Open
Windows Update to confirm that you have automatic updating turned on and that you've
downloaded and installed all the latest critical and security updates.

Adjust Internet Explorer security settings
You can adjust the security settings in your Internet Explorer web browser to specify
how much—or how little—information you want to accept from a website.
Microsoft recommends that you set the security settings for the Internet zone to Medium
or higher. (If you use Windows 8, Windows 7, Windows Vista, or Windows XP Service
Pack 2 and you use Internet Explorer to browse the web, your browser security settings
for the Internet zone are set to Medium by default.) Internet Explorer also includes a
number of features, such as SmartScreen Filter, to help protect against viruses,
spyware, and many other kinds of malicious, deceptive, or unwanted software.

Download and install antivirus software
Microsoft Security Essentials helps protects your computer from viruses, spyware, and
other unwanted software. It is available as a no-cost download for Windows Vista and
Windows 7.
Note: In Windows 8, Windows Defender replaces Microsoft Security Essentials.
Windows Defender runs in the background and notifies you when you need to take
specific action. However, you can use it anytime to scan for malware if your computer
isn’t working properly or if you clicked a suspicious link online or in an email message.

Surf and download more safely
The best defense against spyware and other unwanted software is not to download it in
the first place. Here are a few tips that can help you avoid downloading software that
you don't want:
▪
Download programs only from websites you trust. If you're not sure whether to
trust a program you are considering downloading, enter the name of the program
into your favorite search engine to see if anyone else has reported that it
contains spyware. Files that end in the extensions .exe or .scr commonly hide
malware. However, even files with familiar extensions such as .docx, .xlsx,
and .pdf can be dangerous.
▪
Never click "Agree" or "OK" to close a window. Instead, click the red "x" in the
corner of the window or press Alt + F4 on your keyboard to close a window.
▪
Be wary of popular "free" music and movie file-sharing programs, and be sure
you understand all of the software that is packaged with those programs.
▪
Use a standard user account instead of an administrator account.
▪
Don't click links on suspicious websites or in email messages. Instead, type the
website address directly into your browser, or use bookmarks.
▪
Don't automatically trust that instant messages, email messages, or messages
on social networking websites are from the person they appear to be from. Even
if they are from someone you know, contact the person before you click the link
to ensure that they intended to send it.

Virus Prevention on Mac Computers
Do Macs get viruses? Do Macs need antivirus software? The short answers are yes,
and yes - but it is a bit more complicated than that. So let’s look at the dangers faced by
Mac users, and the pros and cons of using Mac antivirus software.
The Mac is generally considered to be safe and secure, and there are a number of
reasons why Macs are considered more secure than PCs. Malware writers are less
likely to target Mac users because of the perception that it has a far smaller market
share than Windows. There is also the fact that the Mac operating system is Unixbased, and Unix offers a number of security features built in. In addition, Apple has
included a number of security measures that make attacking a Mac particularly
challenging. These include Gatekeeper, which blocks any software than hasn't been
digitally signed and approved by Apple from running on your Mac without your
agreement. Most of what you’ll read about Mac’s and viruses is overblown fear
mongering hype, and practically all Mac malware has come through third party utilities
and applications. What that means for the average user is that it is very easy to
completely prevent infections and attacks from occurring in the first place, especially
when combined with some general security tips. So here are eight simple ways to
secure a Mac to help prevent viruses, trojans, and malware from effecting you:

1) Disable Java
Flashback and other malware has installed through Java security breaches. Apple has
already released several updates to patch the Java security holes that allowed
Flashback to spread (you should install those), but you can also go a step further and
completely disable Java on the Mac. Frankly, the average person doesn’t need Java
installed on their Mac let alone active in their web browser, disable it and you don’t have
to worry about security holes in older versions of the software impacting your Mac.
1a) Disable Java in Safari
•
Open Safari and pull down the Safari menu, selecting “Preferences”
•
Click on the “Security” tab and uncheck the box next to “Enable Java”

Disabling Java in the Safari browser is reasonably effective, but why not go a step
further and disable it in Mac OS X completely? Chances are high that you won’t miss it,
let alone notice it is disabled.
1b) Disable Java System-Wide in Mac OS X
•
Open the Applications folder and then open the Utilities folder
•
Launch the “Java Preferences” application
•
Uncheck the box next to “Enable applet plug-in and Web Start applications”
•
Uncheck all the boxes next to “Java SE #” in the list below

2) Update Apps and OS X Software Regularly
Apple regularly issues Security Updates and many third party apps do as well, therefore
regularly updating both your OS X System Software and OS X apps are one of the
single best preventative measures you can take to keep a Mac secure. We’ve
hammered home about this repeatedly as a general Mac OS X maintenance tip
because it is important and so easy to do:
1
Open Software Update from the  Apple menu and install updates when
available
2
Open the App Store and download available updates

3) Disable or Remove Adobe Acrobat Reader
Adobe Acrobat Reader has had multiple security breaches recently, therefore you’ll be
safer without it in your web browser. There’s little reason to have Reader installed on a
Mac anyway, OS X includes Preview for viewing PDF’s. Uninstall Adobe Acrobat Reader
by running the bundled uninstaller app, or locate the following file and remove it to
uninstall the Acrobat browser plugin: /Library/Internet Plug-ins/AdobePDFViewer.plugin

4) Install Anti-Virus Software for Mac OS X
Using anti-virus software on the Mac is likely overkill, but it is worth mentioning again.
We’ve talked about the free Sophos anti-virus here before, and though you probably
won’t ever need it, it’s a free and effective way to fight viruses that may end up on the

Mac. If you’re the cautious type and you’d rather be safe than sorry there isn’t much
harm to using it as a preventative measure:
•
Download Sophos Anti-Virus for Mac

5) Disable Adobe Flash
Flash has been used as an attack vector in the past, and Macs stopped shipping with
Flash installed for a reason; basically it’s a crash-prone battery hog that has occasional
security breaches. Many sites use Flash for video and games though, so instead of
uninstalling Flash completely we’ll recommend using a Flash block plugin for your web
browser. This causes all Flash to be disabled by default until you click to allow individual
plugins and instances of the Flash plugin to run, preventing unauthorized Flash from
running in a web browser completely. These plugins are free and available for every
major browser:
•

ClickToFlash for Safari

•

FlashBlock for Chrome

•

FlashBlock for Firefox

6) Disable Automatic File Opening After Download
Safari defaults to automatically opening “safe” files after they’re downloaded. For added
security, disable this feature and manage the opening of downloads yourself:
•
Open Safari preferences and click the General tab
•
Uncheck the box next to “Open ‘safe’ files after downloading”

7) Double-Check Anti-Malware Definitions are Enabled
OS X automatically downloads and maintains a malware definition list which is actively
used to combat potential threats and attacks. This is enabled by default, but you can
double-check to make sure you’re getting the updates as they arrive by insuring the
feature is turned on:
•
Open System Preferences and click on “Security & Privacy”
•
Under the General tab look for “Automatically update safe downloads list” and
make sure it is checked
You can also check the update list manually if you’re concerned the latest version hasn’t
been installed, but as long as you have the feature enabled and have regular internet
access, it probably is.

8 ) Don’t Install Random Software You Didn’t Ask For
If you see a random pop-up window asking you to install random software you didn’t
request, don’t install it! This may sound like common sense, but it’s actually how some
Mac malware propagated in the past. Apple patched the hole that allowed for that to
happen a while ago, but the overall message is still relevant: if you didn’t download or
request an app to be installed and you’re suddenly confronted with an installation
dialog, don’t install it.

The Risk of Using USB Drives
Because USB drives, sometimes known as thumb drives, are small, readily available,
inexpensive, and extremely portable, they are popular for storing and transporting files
from one computer to another. However, these same characteristics make them
appealing to attackers.

- One option is for attackers to use your USB drive to infect other computers. An

-

-

attacker might infect a computer with malicious code, or malware, that can detect
when a USB drive is plugged into a computer. The malware then downloads
malicious code onto the drive. When the USB drive is plugged into another computer,
the malware infects that computer.
Some attackers have also targeted electronic devices directly, infecting items such as
electronic picture frames and USB drives during production. When users buy the
infected products and plug them into their computers, malware is installed on their
computers.
Attackers may also use their USB drives to steal information directly from a computer.
If an attacker can physically access a computer, he or she can download sensitive
information directly onto a USB drive. Even computers that have been turned off may
be vulnerable, because a computer's memory is still active for several minutes
without power. If an attacker can plug a USB drive into the computer during that time,
he or she can quickly reboot the system from the USB drive and copy the computer's

-

memory, including passwords, encryption keys, and other sensitive data, onto the
drive. Victims may not even realize that their computers were attacked.
The most obvious security risk for USB drives, though, is that they are easily lost or
stolen. If the data was not backed up, the loss of a USB drive can mean hours of lost
work and the potential that the information cannot be replicated. And if the information
on the drive is not encrypted, anyone who has the USB drive can access all of the
data on it.

How can you protect your data?
There are steps you can take to protect the data on your USB drive and on any
computer that you might plug the drive into:
•
Take advantage of security features - Use passwords and encryption on your
USB drive to protect your data, and make sure that you have the information
backed up in case your drive is lost.
•

Keep personal and business USB drives separate - Do not use personal USB
drives on computers owned by your organization, and do not plug USB drives
containing corporate information into your personal computer.

•

Use and maintain security software, and keep all software up to date - Use a
firewall, anti-virus software, and anti-spyware software to make your computer
less vulnerable to attacks, and make sure to keep the virus definitions current
Also, keep the software on your computer up to date by applying any necessary
patches.

•

Do not plug an unknown USB drive into your computer - If you find a USB drive,
give it to the appropriate authorities (a location's security personnel, your
organization's IT department, etc.). Do not plug it into your computer to view the
contents or to try to identify the owner.

•

Disable Autorun - The Autorun feature causes removable media such as CDs,
DVDs, and USB drives to open automatically when they are inserted into a drive.
By disabling Autorun, you can prevent malicious code on an infected USB drive
from opening automatically.

What is spam?
Spam is the electronic version of "junk mail." The term spam refers to unsolicited, often
unwanted, email messages. Spam does not necessarily contain viruses—valid
messages from legitimate sources could fall into this category.

How can you reduce the amount of spam?
There are some steps you can take to significantly reduce the amount of spam you
receive:

•

Don't give your email address out arbitrarily - Email addresses have become
so common that a space for them is often included on any form that asks for your
address—even comment cards at restaurants. It seems harmless, so many
people write them in the space provided without realizing what could happen to
that information. For example, companies often enter the addresses into a
database so that they can keep track of their customers and the customers'
preferences. Sometimes these lists are sold to or shared with other companies,
and suddenly you are receiving email that you didn't request.

•

Check privacy policies - Before submitting your email address online, look for a
privacy policy. Most reputable sites will have a link to their privacy policy from any
form where you're asked to submit personal data.

•

Be aware of options selected by default - When you sign up for some online
accounts or services, there may be a section that provides you with the option to
receive email about other products and services. Sometimes there are options
selected by default, so if you do not deselect them, you could begin to receive
email from lists those lists as well.

•

Use filters - Many email programs offer filtering capabilities that allow you to
block certain addresses or to only allow email from addresses on your contact
list. Some ISPs offer spam "tagging" or filtering services, but legitimate messages
misclassified as spam might be dropped before reaching your inbox. However,
many ISPs that offer filtering services also provide options for tagging suspected
spam messages so the end user can more easily identify them. This can be
useful in conjunction with filtering capabilities provided by many email programs.

•

Report messages as spam - Most email clients offer an option to report a
message as spam or junk. If your has that option, take advantage of it. Reporting
messages as spam or junk helps to train the mail filter so that the messages
aren't delivered to your inbox. However, check your junk or spam folders
occasionally to look for legitimate messages that were incorrectly classified as
spam. You can also report SPAM to the U.S. Government at spam@uce.gov.
(Be sure to forward the SPAM email to them.)

•

Don't follow links in spam messages - Some spam relies on generators that
try variations of email addresses at certain domains. If you click a link within an
email message or reply to a certain address, you are just confirming that your
email address is valid. Unwanted messages that offer an "unsubscribe"
option are particularly tempting, but this is often just a method for
collecting valid addresses that are then sent other spam.

•

Disable the automatic downloading of graphics in HTML mail - Many
spammers send HTML mail with a linked graphic file that is then used to track
who opens the mail message—when your mail client downloads the graphic from

their web server, they know you've opened the message. Disabling HTML mail
entirely and viewing messages in plain text also prevents this problem.
•

Consider opening an additional email account - Many domains offer free
email accounts. If you frequently submit your email address (for online shopping,
signing up for services, or including it on something like a comment card), you
may want to have a secondary email account to protect your primary email
account from any spam that could be generated. You could also use this
secondary account when posting to public mailing lists, social networking sites,
blogs, and web forums. If the account start to fill up with spam, you can get rid of
it and open a different one.

•

Use privacy settings on social networking sites - Social networking sites
typically allow you to choose who has access to see your email address.
Consider hiding your email account or changing the settings so that only a small
group of people that you trust are able to see your address. Also, when you use
applications on these sites, you may be granting permission for them to access
your personal information. Be cautious about which applications you choose to
use.

•

Don't spam other people - Be a responsible and considerate user. Some
people consider email forwards a type of spam, so be selective with the
messages you redistribute. Don't forward every message to everyone in your
address book, and if someone asks that you not forward messages to them,
respect their request.

Where the danger lies - Hackers use a technique called “Phishing to try and get
you to download adware, malware and viruses. Phishing is particularly dangerous
because once criminals get a victim's password for one Web site they can often use it to
get into other accounts where people have re-used the password.
What is phishing?
Phishing is an attempt, usually via e-mail, to trick people into revealing sensitive
information like usernames, passwords, and credit card data by pretending to be a bank
or some other legitimate entity. The e-mails typically include a link to a Web site that
appears to be legitimate and which prompts users to provide information. Sometimes,
the phishing e-mail will include a form in an attachment to fill out. One common tactic
phishers use is to pretend to be from the fraud department of a financial institution or
online retailer like PayPal and ask for information to be provided to prevent identity
fraud. In one case, a phishing e-mail purporting to be from a state lottery commission
asked recipients for their banking information so their "winnings" could be deposited into
their accounts. Phishers also are increasingly exploiting interest in news and other
popular topics to trick people into clicking on links. One e-mail purportedly about swine
flu asked people to provide their name, address, phone number, and other information

as part of a survey on the illness. And users of social networks are becoming popular
targets. Twitter users have been directed to fake log-in pages.
Here are other examples of phishing attacks?
•
An e-mail scam asks PayPal customers to provide additional information or risk
getting their account deleted because of changes in the service agreement.
Recipients are urged to click on a hyperlink that says "Get Verified!"
•
E-mails that look like they come from the FDIC include a subject line that says
"check your Bank Deposit Insurance Coverage" or "FDIC has officially named
your bank a failed bank." The e-mails include a link to a fake FDIC site where
visitors are prompted to open forms to fill out. Clicking on the form links
downloads the Zeus virus, which is designed to steal bank passwords and other
information.
•
E-mails that look like they come from the IRS tell recipients that they are eligible
to receive a tax refund and that the money could be claimed by clicking on a link
in the e-mail. The link directs visitors to a fake IRS site that prompts for personal
and financial information.
•
A legitimate-looking Facebook e-mail asks people to provide information to help
the social network update its log-in system. Clicking the "update" button in the email takes users to a fake Facebook log-in screen where the user name is filled
in and visitors are prompted to provide their password. When the password is
typed in, people end up on a page that offers an "Update Tool," but which is
actually the Zeus bank Trojan.
Tell-tale signs of a phishing attempt?
Many phishing attempts originate from outside the U.S. so they often have misspellings
and grammatical errors. Some have an urgent tone and they seek sensitive information
that legitimate companies don't typically ask for via e-mail.
Identifying a Phishing email?
- Check the sender information to see if it looks legitimate. Criminals will choose
addresses that are similar to the one they are faking. For instance, phishers have
used "Alerts@Paypal.co.uk." However, legitimate PayPal messages in the U.S. come
from Service@paypal.com" and include a key icon.
- Most phishing e-mails come from outside the U.S. so an address ending in ".uk" or
something other than ".com" could indicate it's a phishing attempt. The e-mail
address may also be obscured. Hitting "reply all" may reveal the true e-mail address.
You can also set your e-mail preferences to show "full header" to see the full e-mail
address and other information. If you are at all unsure whether the e-mail is
legitimate, go to the company's Web site to see the address listed.
- Legitimate companies tend to use customer names or user names in the e-mail, and
banks often will include part of an account number. Phishing emails typically offer
generic greetings, like "Dear PayPal customer.
- Inspect the hyperlinks inside the body of the e-mail. Phishers typically will use
subdomains or letters or numbers before the company name, and sometimes the
words in the links are misspelled. For example, www.BankA.security.com would link

-

-

to the 'BankA' section of the 'security' Web site. Often, it's difficult to tell if the link is
legitimate just by looking at it. By mousing over the link you can see the real address
on the bottom of most Web browsers. (Do not try this on a mobile device as it will
probably open the link.)
In addition, PayPal, Amazon, banks, and many other businesses use the SSL
(Secure Sockets Layer) protocol which is designed to ensure that customers are
visiting the real site. That means https:// will be seen in the URL address bar instead
of just http:// and usually there will be some other change in the address bar. For
instance, PayPal displays a "P" and its name is highlighted in green at the front of the
URL. The major browsers have antiphishing measures designed to detect malicious
sites. Some phishers also try to hide the real Web address they are sending victims
to by using URL shortening services.
If the e-mail has an attachment, be wary of .exe files. Scammers like to hide viruses
and other malware there so it executes when opened.
Do not be fooled by the look of the Web site you may be directed to. The Web site
may look just like a real bank or PayPal page, including the use of the real logos and
branding. It could be a good fake page or it could be a legitimate page with a phishing
pop-up window on top.

How can phishing attacks be avoided?
•
Try to stay off spam lists. Don't post your e-mail address on public sites. Create
an e-mail address that is less likely to get included in spam lists. For instance,
instead of mfile@xyz.com, use m.file.tx@xyz.com.
•
If an e-mail looks reasonable contact the company directly if you receive an email asking you to verify information. Type the address of the company into the
address bar directly rather than click on a link. Or call them, but don't use any
phone number provided in the e-mail.
•
Don't give out personal information requested via e-mail. Legitimate companies
and agencies will use regular mail for important communications and never ask
customers to confirm log-in or passwords by clicking on links in e-mail.
•
Look carefully at the Web address a link directs to and type in addresses in the
browser for businesses if you are uncertain.
•
Don't open e-mail attachments that you did not expect to receive. Don't open
download links in IM. And don't enter personal information in a pop-up window or
e-mail.
•
Make sure you are using a secure Web site when submitting financial and
sensitive information.
•
Change passwords frequently. Don't use the same password on multiple sites.
•
Regularly log into online accounts to monitor the activity and check statements.

Checkup #3: Passwords

Using Secure Passwords
Create strong passwords
Passwords are the first line of defense against break-ins to your online accounts and
computer, tablet, or phone. Poorly chosen passwords can render your information
vulnerable to criminals, so it is important to make your passwords strong.
To help you create strong passwords, follow these guidelines:
▪
Strong passwords are phrases (or sentences) at least eight characters long—
longer is better—that include at least three of the following: uppercase and
lowercase letters, numerals, punctuation marks, and symbols.
▪
Give passwords the thought they deserve, and make them memorable. One way
is to base them on the title of a favorite song or book, or a familiar slogan or other
phrase. (Don’t use the examples below!)
Example phrases: I love my new Xbox One
Example passwords: Ilove!mynewxbox1
▪

Don’t share passwords with others or store them on the device they’re designed
to protect.(See next section)

Avoid common password pitfalls
Cybercriminals use sophisticated tools to rapidly crack passwords, but you can help foil
their attempts.
DO NOT USE:
▪
Personal identity information that could be guessed or easily discovered, like pet
names, nicknames, birth date, address, or driver's license number.
▪
Dictionary words in any language (including the word password—the most
common password in the English language!).
▪
Words spelled backwards, abbreviations, and common misspellings
(accommodate, remember).
▪
Common letter-to-symbol conversions, such as changing "o" to "0" or "i" to "1" or
“!”.
▪
Sequences or repeated characters. Examples: 12345678, 222222, abcdefg, or
adjacent letters on your keyboard (such as qwerty).

Protect your passwords
Secure your passwords
▪

Don’t share your passwords with anyone, and don’t store them on the device
they’re designed to protect. Never send a password in email or instant messages
because they’re not reliably secure.
▪
Use a unique password for each website. If someone steals a password that you
use on many different sites, all the information it protects is at risk. Keep track of
your passwords on a sheet of paper stored in a secret place.
▪
Change your passwords regularly, particularly those that safeguard your
computer, important accounts (like email or Facebook), and sensitive information,
like financial and health data.
▪
Whenever possible, change passwords immediately on accounts you suspect
may have been compromised.
Tip: When you’re asked to give answers to security questions, give an unrelated
answer. For instance, if the question is "Where were you born?," you might answer
"Green." Answers like these can’t be found by trolling Twitter or Facebook. (Just be sure
they make sense to you, so you'll remember them.)

Don’t be tricked into revealing your passwords
Criminals can try to break your password, but sometimes it’s easier to exploit human
nature and trick you into revealing it.
You may get an email message pretending to be from an online store (like eBay or
Amazon) or a phone call from your “bank,” that tries to convince you of the “legitimate”
need for your password (or other sensitive information). It could be a phishing scam.
(You may have heard these con games referred to as social engineering.)
You are most vulnerable to scams that look genuine.
▪
In general, be wary of the sender, even someone you know or a company you
trust. (For example, a crook may have hijacked a friend’s account and sent email
to everyone in the friend’s address book.) Treat all unsolicited requests for
sensitive information with caution.
▪
Never share your password in response to an email or phone request—for
example, to verify your identity—even if it appears to be from a trusted company
or person.

Where the danger lies - Password cracking is the process of guessing or
recovering a password from stored locations or from data transmission system. It is
used to get a password for unauthorized access or to recover a forgotten password. In
penetration testing, it is used to check the security of an application. In recent years,
computer programmers have been trying to create algorithms for password cracking in
less time. Most of the password cracking tools try to login with every possible
combination of words. If login is successful, it means the password was found. If the
password is strong enough with a combination of numbers, characters and special
characters, this cracking method may take hours to weeks or months. A few password

cracking tools use a dictionary that contains passwords. These tools are totally
dependent on the dictionary, so success rate is lower. Programmers have developed
many password cracking tools, and unfortunately, the majority are free and easily found
using any search engine. (One password cracking website designed for hacking
Facebook sites claims it can run 8 million password combinations a minute.)

Setting Up Two-Step Verification
Two Step Verification is offered by Apple, Microsoft & Google and adds an very
important level of security to your accounts. While your password is used to verify you,
the 2nd step in using Two Step Verification requires that you verify your device. This is
done by texting you a PIN Number whenever there is an attempt to access one of your
accounts from a different computer/device than is registered to you. Thus, if someone
does have your Email or Cloud password, they still could not hack your account without
having your mobile phone to receive the PIN Number. You can easily set up Two Step
Verification by going to the following websites and following the instructions at the site:
For iPhone/iPad and Mac Computers:
http://support.apple.com/en-us/HT204152
For Any Devices Running a Windows Operating System:
http://windows.microsoft.com/en-us/windows/app-passwords-two-step-verification
For Devices with Google Accounts:
https://www.google.com/landing/2step/

Checkup #4: Mobile Device Security

Take Care of your Mobile Device
Whether your mobile phone is a older phone or a smartphone, staying in touch with
family and friends, keeping up with the news and weather, or playing the latest games
has never been so effortless. But there are risks. A stolen phone can result in the theft
or loss of sensitive data—even your identity. It can compromise your bank or other
online accounts, including apps that let you pay for items in physical stores with your
phone (mobile wallets). Downloading a malicious app can do the same—as well as cost
you money by setting your phone to automatically dial premium numbers (toll fraud).
Cell phones also have the ability to send and receive text messages. Even on a mobile
device, an attacker may be able to accomplish the following:
•

•

•

•

Abuse your service - Most cell phone plans limit the number of text messages
you can send and receive. If an attacker spams you with text messages, you may
be charged additional fees. An attacker may also be able to infect your phone or
PDA with malicious code that will allow them to use your service. Because the
contract is in your name, you will be responsible for the charges.
Lure you to a malicious web site - While PDAs and cell phones that give you
access to email are targets for standard phishing attacks, attackers are now
sending text messages to cell phones. These messages, supposedly from a
legitimate company, may try to convince you to visit a malicious site by claiming
that there is a problem with your account or stating that you have been
subscribed to a service. Once you visit the site, you may be lured into providing
personal information or downloading a malicious file.
Use your cell phone or PDA in an attack - Attackers who can gain control of
your service may use your cell phone or PDA to attack others. Not only does this
hide the real attacker's identity, it allows the attacker to increase the number of
targets.
Gain access to account information - In some areas, cell phones are
becoming capable of performing certain transactions (from paying for parking or
groceries to conducting larger financial transactions). An attacker who can gain
access to a phone that is used for these types of transactions may be able to
discover your account information and use or sell it.

Use the following five simple practices a habit to help reduce your risk.

Lock your device with a PIN or password
Lock your phone as well as your SIM card and mobile wallet (if you have them).
▪
For your PIN, avoid numbers from your birth date, social security or
national identification number, phone number, or the like. If you have a
password option, use it!

▪
▪

Keep your PIN or password private. Period. Don’t send it in email, instant,
or text messages (they may not be secure), and don’t store it on your
phone.
Enable the feature that erases the phone if someone tries to guess the
PIN too many times.

Use a phone finder
Turn on the service or download an app that helps you find your phone if it’s lost
or stolen. This allows you to ring your phone, locate it on a map, lock it, or erase
its data—all remotely from your browser (like Internet Explorer or Firefox). Note
that this regularly reports the phone’s location—and yours. Consider how long
this history is retained and whether it can be shared or sold.

Defend your phone/tablet against malware
Phones are most susceptible to a kind of malicious software (malware) known as
a Trojan horse. It hides in a seemingly harmless app like a ringtone or game, but
contains hidden code designed to exploit or damage the system; running the app
unleashes the malware on your phone.

Install reputable apps
Download apps only from major app stores—the Windows Phone Store or
Apple’s App Store, for example—and stick to popular apps with numerous
reviews and comments.

Keep your phone/tablet up to date
▪
▪

Just as you do on your computer, accept and install all updates offered for
both the phone itself and the apps on it.
Uninstall apps that you don’t use.

Don’t jailbreak your phone
Most phones will run only software that their operating system trusts. Jailbreaking
(or unlocking) a phone enables it to run untrusted software, which is much more
likely to carry a harmful virus.

Accept incoming content cautiously
▪
▪
▪

Avoid clicking links in ads and contests that promise free prizes or gifts.
Watch out for text messages that look too good to be true.
If your phone works with Bluetooth technology or NFC standards (which
support, for example, mobile wallets), turn them off if you’re not using
them. (Both technologies allow two devices to "talk" to each other
wirelessly at close range.) This blocks unwanted downloads and keeps
intruders from reading data stored on your phone.

Protect your privacy
▪

▪
▪

Do not bank, shop, check email, or do other business that exposes your
user name or password over "borrowed" or public Wi-Fi (like a hotspot). It
is safer to use the mobile phone’s network, which encrypts data as it is
transmitted.
Be wary of features that offer to save user names or passwords in your
browser and financial service or other apps that store sensitive data.
Share your location only with those you trust.

Use GPS features wisely
Many services—weather, movies, and maps, for example—personalize results
by using location data from your phone’s Global Positioning System (GPS) or
nearby Wi-Fi access points and cell towers. Your phone’s camera can use GPS
to automatically embed information about the spot where a photo was taken,
called geotagging. Facebook and Twitter can also use GPS to geotag status
messages and tweets posted from your phone. This can be a risk because you
may not be able to control how that data is used and by whom.
▪
▪
▪

Think carefully before you turn on geotagging.
Limit the apps that you allow to access your location and link to social
media with care.
Get permission from others before you tag them in photos or check them
in.

Back Up your Phone/Tablet on a regular basis
Back up your phone regularly to your computer, cloud storage, or both.

Instructions for Backing Up Your iPhone/iPad:
Backing Up using iCloud
iCloud automatically backs up your iOS device information daily over Wi-Fi when your
device is turned on, locked, and connected to a power source.
Back up automatically
- On your iOS 8 device: Go to Settings > iCloud > Backup, then turn on iCloud Backup.
- On your iOS 7 device: Go to Settings > iCloud > Storage & Backup, then turn on
iCloud Backup.
Back up manually
- On your iOS 8 device: Go to Settings > iCloud > Backup, then tap Back Up Now.
- On your iOS 7 device: Go to Settings > iCloud > Storage & Backup, then tap Back Up
Now.

Important: If you don’t back up your iOS device to iCloud for 180 days or more, Apple
reserves the right to delete your device’s iCloud backups.
Backing Up using iTunes
Use these steps to back up the content on your iOS device to iTunes on your computer:
- Make sure your computer has the latest version of iTunes.
- Connect your device to your computer.
- Choose File > Devices > Back up, or simply click on the Device Icon that will appear
in the upper left corner of your iTunes screen.
You can also back up by syncing your device with your computer. When you use iTunes
to sync, backing up is the first step.
To check that the backup finished successfully, open iTunes Preferences and select the
Devices tab. You'll see the name of the device along with the date and time iTunes
created the backup.

Instructions for Backing Up Your Android Phone/Tablet
Backing Up using Google Cloud
- Press the "Home" button on your phone to get to the Home screen.
- Hit the "menu" button next and select "System Settings.”
- Select the "Privacy" option right under "Language" in the Settings screen.
- Make sure the "Back up my data" and "Automatic restore" boxes are checked. Click
"Backup my account" to ensure extra redundancy for backing up your data on the
cloud.
- Select an account there for a backup account, or click "Add account.”
- Select "Existing" for a different account that already exists, or click "New" to set up a
new one. This will help ensure your data stays safe.
Backing Up to your Computer
- Connect your Android device to your computer (Windows or Mac should both work)
via the USB cable.
- On your Android, pull down the main menu (swipe down from the top of the screen)
and select "USB connection.”
- On the next page, choose USB Mass Storage and hit OK.
- You will see a new drive or "Removable Disk" appear on your computer for the SD
card. Open it up, and copy all the files inside to a new location on your computer. Put
the date right into the name of the folder so you can very easily identify it and when it
was created.

Instructions for Backing Up Your Windows Phone/Tablet
The backup process using Windows 8.1 is now automatic, and it can be found under
Settings > Backup > Apps + Settings. Tapping that screen will give you two options, one
for Settings backup and another for App backup. Either one can be toggled on or off to

make sure backups happen on a regular basis. When enabled, the backups will happen
automatically. Likewise, you can do a ‘back up now’ for saving manually in addition to
managing those backups, including deletion. All your data is saved to your OneDrive
account. You can find more information about backing up Windows Phones at: http://
www.windowsphone.com/en-us/how-to/wp8/settings-and-personalization/back-up-mystuff

Syncing Your Devices
By using your same iCloud, Google, or OneDrive account on all your mobile devices
and computers, your devices will always be in sync and any data one one device will be
accessible on all similar devices. (As long as all your devices use the same platform.
This is why you should always try to buy devices from the same company.)

Checkup #5: Online Reputation & Safety

Your Online Reputation
Chances are you already have an online reputation, even if you do not know it.
On the Internet, you create an image of yourself through the information you share in
blogs comments, tweets, snapshots, videos, and links. Others add their own opinions
(good or bad), which contribute to your reputation. Anyone can find this information and
use it to make judgments about you.

Find out what is on the Internet about you
Search Yourself
Type your first and last name into several popular search engines. Search for
images as well as text.
Be specific to increase your search effectiveness. Put quotation marks around your
name. Specify the city where you live, your employer, or other keywords that apply only
to you.
Avoid searching for national identity numbers or Social Security numbers. If you
happen to see these (or other sensitive data like credit card numbers, grades, or health
information) in search results, ask the website owner to remove the data immediately.
Search all variations of your name. If you have ever used a different name or
nickname, if you use your middle name or initial, or if your name is frequently
misspelled, check these as well. Include personal domain names (for example,
yourname.com) in your search.
Check sites you frequent. Search online directories and sites that compile public
records, genealogy sites, the websites of organizations to which you belong or donate
time or money, and the like.

Search blogs and social networks
Review what others have posted about you in comments, pictures, or videos. Explore
their blogs, personal pages on social networking sites (Facebook, LinkedIn, Twitter), or
photo-sharing sites like Flickr and Instagram. (Parts of these sites are inaccessible to
many search engines, so you must look separately.)
You can use a free service such as Skipease (http://www.skipease.com) to track down
information from different sites and social networks. (If you have access to a TOR
Browser you also should do a Deep Web search.)

Evaluate your online reputation
After you have gathered this information, think about the story it tells. Does it reflect the
way you want others to perceive you? If not, what is missing? Is it accurate? If not, what
should be deleted or corrected? Do you need more than one online profile—whether
professional, personal, or for an area of interest, like a hobby or volunteer work? If so, is
it okay to mix information from different profiles? Do you want your profiles to be public
or more private? Your answers to these questions are important because information
online is searchable, often permanent, and may be seen by anyone on the Internet.
Unlike data stored on paper, online information can be aggregated by Internet search
engines and other tools, which makes it easier for others to put together their own idea
of who you are. Websites may archive what you have posted and data they have
collected from you. Friends (or ex-friends) may divulge it; malicious programmers and
security lapses may expose it.

Protect your online reputation
Act online in a manner that reflects the reputation you want to earn—whether you are
building on an existing reputation, discarding an old persona, or creating a new one.

Think before you share
Before you put anything online, think about what you are posting, who you are sharing it
with, and how this will reflect on your reputation. Would you be comfortable if others
saw it? Or saw it ten years from now? When you choose photos and videos, think about
how others might perceive them. Talk with your friends about what you do and do not
want shared. Ask them to remove anything that you do not want disclosed.

Treat others as you would like to be treated
Be civil in what you say and show on the web. Respect the reputation and privacy of
others when you post anything about them (including pictures) on your own pages or on
others' pages or public sites. Remove anything that does not honor this.

Stay vigilant about what the Internet is saying about you
Sign up for personal alerts. Some search engines will automatically notify you of any
new mention of your name or other personal information. From time to time, search for
yourself to see what additional information has been catalogued in search engines.
Periodically reassess who has access to your pages. Friends change over time; it is
okay to remove those who no longer belong.

Polish your reputation
Publish positive information about yourself
To be your online best, create what you want others to see. Link anything you publish to
your name. Join a professional network such as LinkedIn or CareerBuilder. Put together
a robust profile and make connections with colleagues there. Ask for recommendations

from those who know your work well. Comment on professionally-oriented blogs,
participate in online forums, and review books on subjects in which you have expertise.
Start a blog or register a website in your own name.
▪
Publicize yourself through clear writing, straightforward design, and high quality
images.
▪
Write regularly (at least twice a month) on a subject about which you are
knowledgeable.
▪
Invite visitors to make comments to create a conversation.

Consider separating professional and personal profiles
Use different email addresses, screen names, blogs, and websites for each profile.
Do not link your real name (or sensitive personal information such as your home and
email addresses, phone numbers, or photos) with other profiles that you create. Add
personal information to your professional profile judiciously and only as it reflects well
on that image. Avoid cross references to personal sites. Some social networks let you
build separate friends lists—for family, your sports team, work, and so on—so that you
can manage what you share within one profile. Look for Settings or Options to help
you manage who can see your profile or photos, how people can search for you, who
can make comments, and how to block unwanted access by others.

Restore your online reputation
If you find information about yourself that does not fit the reputation you want, act
quickly. The longer it stays public, the greater the chance that it will be spread or
archived.
In a respectful way, ask the person who posted it to remove it or correct an error. If it is a
correction, ask him or her to include a notice (CORRECTION or UPDATED) right next to
the original (incorrect) material.
If the person does not respond or refuses to help, ask the website administrator to
remove the digital damage.
If you feel a public correction is necessary, present your case simply and politely without
attacking the person.

Cyber Defense Basics for Children
If you're a parent, you can help your kids use the Internet safely by teaching some basic
rules. Here are some basic lessons that parents can help their kids learn.

Encourage kids to keep passwords secret
Kids create online user names and passwords for school, game websites, social
networking, posting photos, shopping, and more. According to a study by Teen

Angels of Wired Safety.org, 75 percent of 8- to 9-year olds shared passwords
with someone else, and 66 percent of girls in grades 7 to 12 said they shared
their password with someone else.
The first rule of Internet safety is: keep passwords secret. Encourage kids to treat
their passwords with as much care as the information that they protect.
Here are some rules that kids should know and follow.
▪
Don't reveal passwords to others. Keep your passwords hidden, even
from friends.
▪
Protect recorded passwords. Be careful where you store passwords that
you record or write down. Don't store passwords in your backpack or
wallet. Don't leave records of your passwords anywhere that you would
not leave the information that the passwords protect. Don't store your
passwords on a file in your computer. Criminals look there first.
▪
Never provide your password over email or in response to an email
request. Any email message that requests your password or requests that
you to go to a website to verify your password could be a kind of fraud
called a phishing scam. This includes requests from trusted sites that you
might visit all the time. Fraudsters often create fake email messages with
logos and language from real sites.
▪
Do not type passwords on computers that you do not control. Don't
use public computers in your school, library, Internet cafes, or computer
labs for anything other than anonymous Internet browsing. Don't use
these computers for any account that requires a user name and password.
Criminals can purchase keystroke logging devices for very little money
and they take only a few moments to install. With these devices malicious
users can gather information typed on a computer from across the
Internet.

Help your kids use social networking safely
Your kids may use social networking sites designed for children such as Webkinz
or Club Penguin, or sites designed for adults such as YouTube, MySpace, Flickr,
Twitter, Facebook, and others. Kids use social networks to connect with others
who might live halfway around the world and with their peers whom they see
every day at school.
Kids should understand that many of these social networking sites can be viewed
by anyone with access to the Internet. As a result, some of the information they
post can make them vulnerable to phishing scams, online bullying, and Internet
predators. Here are several ways to help kids use social networking sites safely.
▪
Communicate with kids about their experiences. Encourage your
children to tell you if something they encounter on the Internet makes
them feel anxious, uncomfortable, or threatened. Stay calm and remind
your kids it is OK to bring it to your attention. Let them know you will work
with them to help resolve the situation positively.

▪

▪

▪

▪

▪

▪

▪

▪
▪

▪

Establish Internet rules. As soon as your children use the Internet on
their own, establish rules for Internet use. These rules should define
whether your children can use social networking sites and how they can
use them.
Ensure your kids follow age limits. The recommended age to sign up
for social websites is usually 13 and over. If your children are under the
recommended age, do not let them use the sites. You cannot rely on the
services themselves to keep your underage child from signing up.
Educate yourself. Evaluate the sites that your child plans to use and
make sure both you and your child understand the privacy policy and the
code of conduct. Find out if the site monitors content that people post.
Also, review your child's page periodically.
Teach your children never meet anyone in person that they've
communicated with online only. Kids are in real danger when they meet
strangers in person whom they've communicated with online only. It might
not be enough to simply tell your child not to talk to strangers, because
your child might not consider someone they've "met" online to be a
stranger.
Encourage your children to communicate with people they already
know. You can help protect your children by encouraging them to use
these sites to communicate with friends, but not with people they've never
met in person.
Ensure your kids don't use full names. Teach your child to use only a
first name or nickname, but not a nickname that would attract
inappropriate attention. Also, do not allow your children to post the full
names of their friends.
Be wary of identifiable information in your child's profile. Many social
websites allow kids to join public groups that include everyone who goes
to a certain school.
Be careful when your children reveal information that can identify them,
such as a school mascot, a workplace, or the name of the town they live
in. Too much information can make your children vulnerable to online
bullying, Internet predators, Internet fraud, or identity theft.
Consider using a site that is not very public. Some websites allow you
to password-protect your site or use other methods to help limit viewers to
only people your child knows.
Be smart about details in photographs. Explain to your children that
photographs can reveal a lot of personal information. Encourage your
children not to post photographs of themselves or their friends with clearly
identifiable details such as street signs, license plates on their cars, or
their school name on clothing.
Warn your child about expressing emotions to strangers. You've
probably already encouraged your kids not to communicate with strangers
directly online. However, kids use social websites to write journals and
poems that often express strong emotions.

▪

Explain to your children that anyone with access to the Internet can read
their words and predators often search out emotionally vulnerable kids.
Removal of your child's page. If your children refuse to follow the rules
you've set to help protect their safety and you've attempted to help them
change their behavior, you can contact the social website your child uses
and ask them to remove the page. You may also want to investigate
Internet-filtering tools as a complement to, not a replacement for, parental
supervision.

Beware of online fraud
According to the Federal Trade Commission, 31 percent of reported victims of
identity theft are young people. Teenagers make attractive targets because they
have good credit ratings and little debt, and they tend to be less savvy than
adults about how to keep personal information secure. Some things that your
children should know in order to be smart consumers and avoid online fraud
▪
Never share personal information. Don't give out personal information,
such as your full name or hometown, in an instant message (IM) or a chat
room unless you are certain of the identity of the person with whom you
are chatting.
▪
Log off in public. If you use computers in a library or Internet cafe, log off
completely before you leave. You don't know what software is installed on
these computers or what it does and it might have keystroke tracking
software installed.
▪
Use only secure sites. If your kids shop on the web, they should be sure
the URL of any site where they enter financial information begins with
https:// and features a yellow lock icon in the bottom right corner or a
green address bar. They can click the icon or address bar to check the
security certificate for the site.

Where the danger lies Catfishing:
Coined from the independent film "Catfish," which follows a filmmaker who discovers
the truth about the online relationship he has been conducting with a woman whom he
has never met, "catfishing" occurs when a user creates a false or highly-exaggerated
social media profile for the purposes of conducting a relationship online. Some profiles
are created out of boredom or loneliness, while others are created to exact revenge or
cause embarrassment to the targeted party.
Common signs[1] that you are being catfished can include:
•
Inability to contact the other party "in person" - their cell phone is broken or has
been stolen, they will not use Skype or SnapChat, they will not or cannot meet
you in public despite the seriousness of your relationship.
•
Their photographs appear to be highly edited, stylized, or otherwise unrealistic.
You can search Google by image file in order to determine whether the photos
you've received are legitimate.

•

Details of their personal life consistently changing, or they have a life story that
seems unbelievable or outlandish. If the relationship becomes too intense, they
may develop a life-threatening illness, or face another threat to their "life" that
could terminate the relationship. Your best resource here is your instinct for the
truth, and to keep track of variations in their stories.

Education
Actions in the digital world can have far-reaching consequences in real life.
Inappropriate posts on social media can have severe repercussions on a student's
academic career, and students can lose jobs, internships and even interviews because
of the information potential employers are finding out about students on their social
networking accounts.
While administrators are not monitoring social networking sites, if information or pictures
on a student's account that violate policy are brought to their attention or are reported to
them, they will follow up and investigate further.
Compromising and inappropriate pictures, statements or other information on student
social networking accounts can hurt students' chances to gain (or even be considered
for) employment. Employers take the images that students are portraying on social
networking sites very seriously as a reflection of personal character.
High school and college athletes may find that their social media profiles fall under
additional scrutiny. Many universities and colleges will monitor the social media profiles
of recruits and current athletes to determine that athlete's character and ability to
represent the university, and some forms of social media contact may constitute a
violation of NCAA regulations[2]. Speak with your coach or an Athletics Department staff
member should you have questions regarding your social media actions.

Employment
A recent survey confirms this: A whopping 70 percent of U.S. business managers say
they decided not to hire a job candidate based upon something found out about her
online. So it's crucial to keep your virtual self, well, virtuous. Here's how.
Clean up your pages
Social-media sites, like Facebook and Twitter, appear high in search results, so opt for
the highest privacy settings on these networks. Also, remove complaints about your job
or boss, any confidential work information, and photos of yourself acting in a way that
could be construed as inappropriate. Do the same for any photo-sharing services you
use. If an unflattering photo appears on someone else's page, ask her to remove it.
(Alas, she doesn't have to comply.) If it's pornographic, it's a good idea to alert the
authorities. Got an offer? Great. But don't announce it on Facebook until you clear it
with your employer-to-be. People have been fired after posting online about their
employment without the sanction of the new boss, experts say. Stick with spreading
your good fortune in person.

Checkup #6: Creating a Virtual Private Network

What is a VPN?
A VPN or Virtual Private Network is a network connection that enables you to create a
secure connection over the public Internet to private networks at a remote location. With
a VPN, all network traffic (data, voice, and video) goes through a secure virtual tunnel
between the host device (client) and the VPN provider’s servers, and is encrypted. VPN
technology uses a combination of features such as encryption, tunneling protocols, data
encapsulation, and certified connections to provide you with a secure connection to
private networks and to protect your identity.
VPN connections technically give you all the benefits of a Local Area Network (LAN),
which is similar to that found in many offices but without requiring a hard-wired
connection.
Early VPNs were often set up to give individual employees secure remote access to
their company networks, hence the name "virtual private network". By connecting to the
company’s network, an individual employee can access all the company’s resources
and services as if the employee were inside the company.
Since then, VPNs have evolved to provide the same level of secure communication
between any device on the internet. Today, using VPN is increasingly popular among
consumers as a means to protect their privacy online, secure their browsing sessions,
and get unrestricted access to content or websites that are otherwise blocked or
censored.

Types of VPNs
VPNs differ by architecture, purpose of usage, and accessibility. Two basic types of
accessibility are site-to-site VPN and remote access VPN.

Figure 1. Site-to-Site VPN and Remote Access VPN connecting to a Corporate Network
Site-to-site VPNs are used in the corporate environment. A site-to-site VPN ensures
the safe encrypted connection of two or more local area networks (LANs) of the same
company or of different companies. It means two geographically separated offices are

virtually bridged together into a single LAN and users can access data throughout this
network.
Remote Access VPNs connect an individual computer to a private network. This type
of VPN can be divided again into two groups:
•

Corporate VPNs – Corporate VPNs allow business travelers and telecommuters
to connect to their company networks and remotely access resources and
services on the networks. When a user connects his/her device to the company’s
VPN, the VPN thinks that the user’s computer is on the same local network as
the VPN.

•

Personal VPNs – Personal VPNs provide consumers with the same private and
secure connection as the corporate VPNs. However, personal VPNs are not used
to connect to private networks to access private resources.

•

Nowadays, consumers use personal VPN services mainly to browse the web
anonymously, secure their web browsing sessions at public WiFi with HTTPs
encryption, and bypass internet restrictions to get access to blocked websites
and internet services (i.e. Skype, Gmail).

•

Personal VPN services are especially useful when connecting to a public WiFi
network. It is estimated that nearly 90% of public WiFi networks are not secured.
By using a VPN service, all your internet communications will be encrypted,
making it almost impossible for hackers and snoopers to read and steal your
private information.

•

There are many personal VPN service providers available for consumers to
choose from, with many offering VPN services to consumers for free or for a low
monthly subscription fee. These services also make it easy and quick for you to
install and use a VPN on practically any platform, including mobile and tablet
devices.

Benefits of Masking Your IP Address
A VPN masks your IP address, giving you much greater privacy for your online
activities. Unshielded, this IP address – the unique address for each device on the
internet – can be misused to reveal your identity, location, ISP, and even the specifics of
your online activity.
When you use a VPN, your IP address is masked so you can surf the web
anonymously. Thus, no one can find out where you connect from or what you do online.
Moreover, by exchanging your IP address with the VPN server’s IP address, you can
virtually connect from a geographic location that is different from where you are
physically located.
For instance, you may be sitting inside a coffee shop in Dubai, but by connecting to a
remote VPN server, you can appear to connect to the Internet from another location (i.e.
San Francisco or New York) which hosts the VPN server you’re connecting to.
This enables you to bypass regional internet restrictions and get access to content (i.e.
YouTube, Facebook) or internet services (i.e. Skype, Gmail, Viber) that are otherwise
restricted or censored in the location you are staying in.

Finding a VPN Server
There are many VPN Servers and you can easily search the web to find one. You can
subscribe to a FREE VPN service, which is best if you are only going to use it for a
limited basis, but most free services are slower and may send you ads when
connecting. The PAID VPN Services are faster and more secure, but the price will range
from $5.00 to $10.00 per month. The service I use is Express VPN, which is a little over
$8.00 per month. Once you have subscribed to a service you will be provided the
information needed to configure your devices to their server.

How to Configure Your Devices to a VPN
Windows Computer/Tablet
Connecting to a VPN Server or Router

1. In the Network and Sharing Center (under Control Panel, Network and Internet),
there is an option to "Set up a new connection or network." The next option is to click on
"Connect to a Workplace" in order to start the connection wizard, and then select "Use
my Internet connection (VPN)" option to begin the process. If you have a 3G card
installed, you may first see a prompt to use the 3G card instead of creating a "new"
connection. In this case, you want the "new" connection so that you can use your
existing Internet connection (yes, it's a little confusing).
A far easier way to get to this point is to click on the Start button and type "VPN" in the
search box. It will jump straight to the "Set up a virtual private network (VPN)
connection" window in the wizard.
2. In the Internet address field, enter the IP address of the VPN server or the network's
domain name. This information will usually be provided by the network administrator. If
you are connecting to the home router, then you would put in the IP address of that
router. The destination name field displays the name users would see. If you aren't
going to connect right away, select the "Don't connect now; just set it up so I can
connect later" checkbox. Leaving it unchecked means the client will try to make a
connection at the end of the wizard. If there are multiple users on the Windows 7 box,

you can either check off "Allow other people to use this connection" to make the VPN
connection available to others, or leave it unchecked to ensure no one else has the
option.

3. This screen asks for a username and password. If you leave it blank, you will be
prompted to enter the information when making the actual connection.
4. The final window, if you selected "Don't connect now," will display a "Connect now"
option. You can close the window now, or connect. When you are ready to connect, just
click on the network icon in systray (the icon could be for the wireless network or for the
wired one) and the connection that was created earlier would show up in the list under
"Dial-up and VPN." You can also get here by clicking on "Connect to a network" under
Network and Sharing Center.
5. In the VPN connection box, enter the username and password to the VPN network, if
it isn't already pre-populated, along with the domain provided by the administrator. This
connection should work for a majority of VPN networks.

6. If the connection fails, click on Properties. The most common issue has to do with the
server configuration. Select the "Security" tab in the Properties window. Type of VPN"
should be set to Automatic. Check with the administrator if it should be set to PPTP,
L2TP/IpSec, SSTP, or IKEv2. If it still doesn't work, it's possible you should uncheck
"Include Windows logon domain" under the Options tab.

7. After saving the properties, select Connect to launch the connection. You are now
connected to a VPN server and your connection is safe.

Mac Computer
Connecting to a VPN Server or Router
In order to connect to a virtual private network (VPN) you need to enter configuration
settings into Network preferences. These settings include the VPN server address,
account name, and any authentication settings, such as a password or a certificate you
were given by the administrator of the network.
If you were given a VPN settings file, try double-clicking the file to open Network
preferences and automatically import the settings. If double-clicking the file doesn’t
open Network preferences, choose Apple > System Preferences, click Network, and
then choose Import Configurations from the Action pop-up menu. Select the file and
click Import.
1
2
3
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Choose Apple menu > System Preferences, and then click Network.
Click Add (+) at the bottom of the network connection services list, and then
choose VPN from the Interface pop-up menu.
Choose what kind of VPN connection you want to set up from the VPN Type popup menu, depending on the network you are connecting to, and give the VPN
service a name.
Enter the server address and the account name for the VPN connection.
Click Authentication Settings, and then enter the user authentication information
you were given by the network administrator.
After entering the user authentication information, click OK, and then click
Connect.

Select “Show VPN status in menu bar” to use the VPN status icon to connect to the
network and switch between VPN services.
To remove the VPN configuration, select the VPN network connection service in the list
and click Delete (-).

iPhone or iPad
Connecting to a VPN Server or Router
Configure VPN
Go to Settings > General > VPN.
Choose Add VPN Configuration.

-

Ask your network administrator which settings to use. In most cases, if you set up
a similar VPN on your computer, you can use the same settings on your device.

Turn VPN on or off
After you create a VPN configuration, the option to turn VPN on or off appears in
Settings. When you connect using VPN, the VPN icon appears in the status bar.

If you use multiple VPN configurations, you can switch configurations using Settings >
General > VPN

Android Device
Connecting to a VPN Server or Router
Step 1: Go to the Wireless And Network settings
VPN connections are created from within the Wireless And Network settings window. To
get to this window, click your phone's Menu button. When that menu pops up (Figure A),
tap the Wireless And Network Settings button.

This menu might look quite a bit different depending on the Android handset you're
using; however, the Wireless And Network settings should be fairly universal.
Only one option allows you to set up the VPN connection. In the next screen, tap the
VPN Settings button.

Step 2: Select PPTP for the VPN connection
Now tap the Add VPN button. The screen will display a list of various types of VPNs.
Tap the Add PPTP VPN button to continue.

Step 3: Configure the VPN connection
In this next window, there are four configurations you can set up:
•
VPN Name: Give your VPN a name for the connection listing.
•
Set VPN Server: You will need the actual address for your VPN connection.
•
Enable Encryption: This is set by default, and is more than likely required by your
VPN.
•
DNS Search Domains: If you need to use the internal DNS servers once your
connection is made, enter them here.

When you tap a configuration, a new window will appear. Enter the information required
for that configuration and click OK. (All of the configuration options windows will be
similar in look and feel.)

Step 4: Connect to your VPN
Now that your VPN is set up, it's time to connect. To do this, go back to the VPN listings
window and tap the VPN you just created in order to make the connection. (Your VPN's
name will not be blurred out .)

Once you make a successful connection, you'll see a key icon in your notification area
indicating you are connected to a VPN.

Make sure you keep a close watch on your VPN connections. You don't want to keep
that connection open if you don't need it.
Step 5: Disconnect
Now that you know you can make the connection, you can disconnect by pulling down
your notification drawer, tapping the VPN connection, and then tapping the VPN
connection name to disconnect.

